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If you have followed through the Tutorials (Power*Log Metric Tutorial followed by the Power*Curve
Metric Tutorial) we will now have to add the Type Well Curve data to the Tutorial Wells Data. If you have
not done the Tutorials you will skip ahead to page 7 to import the Power*Curve Tutorial Well Before we
get started we have to add the Type Well Curve to the previously done Power*Curve Tutorial Well.

Adding the Type Well Curve
Congratulations on completing the tutorials. If that is the case then you will have to add the Type Well
TVD Curve layer to this log and then import the Las file to get the Type Well GR Curve into your well

data.

eI
1.) Double click on the “# |con. Acknowledge the Security Information window by clicking on the
button. This will initiate the program and activate a Connect Database window.

D atabazes

PREOLOGY 2078 MPERIAL [Mic
PGEOLOGY 2018 METRIC [Micro

User D ngeology Conrect

Passwiord; Cancel |

Highlight the PGEOLOGY 2018 IMPERIAL (Microsoft Access Driver[*.mbd])) database by clicking on it once.
Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field.
Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field.

N =
NN

3.) Type “pgeology” in the Password field and then click on the button. The program will now load
various dictionaries and then activate an Open Log window.

Mosgt Recently Opened Logs

H Tutorial el Horz Log

W Tutorial Well Fiald Muote: ‘wildzards : % = any range, _ = single character

~ Search Wells by Field or DLSNTS

Choogze field to search
el Name [ Uwi | Spud Date 2 L -l
35-139-23155 Aug 13, 205 Erter Search Sting

i i} |

[ -DLS [Ciomirion Land Surveyp Spstem]

.| Survey
System Loc Ex LSO Sec, Township Range EAW Mer 044 ES.

] O o

~MNTS [Mational Topagraphic Senes Spster)

Survey : :
Systern Loz Ex 14 Unit Black P Guad L Quad. Sistesath EiS:

|

€

Hvailable Logs Search | ™ ByField " ByDLS/NTS Cleat Query | |

H Tutanalwel HZ

Cancel |
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8.) Select the Tutorial Well from the List and then click on the button. This will open your
Tutorial Well Horz Log.

9.) Under the Options menu, click on Log Configuration Builder or click on the H Log Configuration
Builder button on the Toolbar to activate the Log Configuration Builder window.

| Freran Channe

ShowdHide | |

Track Width: 12_ Log fidth IS_ |
e T Layers Layer Config. I

Dirill Rrate (100143206323w500)

Gamma Ray (10014320632 2w500)
Curve Comments Total Gas [1007143206323w500)
Engineering Parameters 100143206323 |

0 “Avsilable Logs————————— Active Log ]
| Log. |[sveTEM =\ et Lag: | Tutarial Well Horz Log =]
£ Tk % Tracks Track Config. !i
i Add Al s |
£ E;LE;IECodB i —l "V 330 Detailed Lihology ®
Core # and Sleeve Data Show Al Y 015 Slide - Rotate
T Srrc o ¥ 0.20 Reservair Quality
Curves ¥ 0.20 Rounding
Curve Fill Hide2ll Y 0.20 Saorting
Date ¥ 050 GranSize
Diepth Y 020 Interpreted Lithology
Detailed Lithology Add >>>'; Y 060 Porosity Grade
Diagenesis N 015 Porosity Type
Dip Meter Data ¥ 015 Oil Show
Delete
Drriling Progress 3 ]

@ |ayers
|

Mud Parameters  [100143206323/500)
Gas Annatations  [100143206323w/500)
Bit Record (10014320632 3w500)

Exit

.

10.)On the left side of the Log configuration builder scroll down and highlight or click on the Curve track.
11.) Click on the Curve layer in the layers portion of the window on the lower left side of the builder to highlight it. In
addition, notice the Layers Radio button & on the left side is activated.

12.) On the right side (Active Log) of the Log Configuration Builder window, click on the Drilling Progress
track to highlight it. This is the track we want to add the Type Well Curve layer to.

13.) Click on the 499> | putton and you will be prompted with the following system message, “Do you want to

?” Click on the

Yes

button.

ADD the selected (layer) from the available log to the active log

Mew Layer Mame: iTPDB el Curve
o 1

14.) This will activate a Get Name window with “Type Well Curve” as the name in the New Layer Name field. Click

button and the Type Well Curve layer will then be added to the Drilling Progress track.

Avalable Logs ———————— ~Aetive Log -
| Lo | [svsTEm e Log: | Tutorial wiell Horz Lo -
© Tracks e Track Config. ||
Add Al 255
Lo paosty —j ¥ 330 Detaled Lihology .
is el Y S
Shawal | || 020 Reservoi Guaty
¥ 020 Aounding
et || ¥ 020 Soting
;J v 050 Grain Size
¥ 0201 Irterpretsd Litkolaay
addsss || DD Porsiy Grade
—j N 015 Parosity Tupe
v 015 O Show
gD Delets v 030 Depth 1
| [Fperan Mhanne i | mmﬁ-_ i
ShowHide
Track Width: 12 Loawidth: |12 ‘
| Mie & Layers Layer Canfig.
= | |
| Lt Typewel Curve [100143206323ws00] I
Dl Fate [100143205323w/500)
Curve Conmerts GammaRap  [100143206323wENN]
Total Gas 11007 43205323/500)

Engineering Parameters (100143208323
Mud Parameters  [100143206323wW/500]
Gas dnnotations  [100143206323w/500)
Eit Record [100143206323w/500)

Exit

:
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Note: The Type Well Curve has not yet been associated with the Type Well Curve layer. This will be done when the

Add Curve window has been correctly filled in when you exit the Log Configuration Builder window.

15.) Click on the st

will generate an Add Curve window.
The Add Curve window...

1.) Type gapi in the Curve Units field.

2.) Make sure ftis in the Depth Units drop box field.

3.) Make sure the Null Value field is -999.25.

4.) Make sure the Depth Interval is 0 and 0 indicating the
present curve scale is applicable to any depth on the log.

5.) Make sure the Curve Scale field values (Left / Bottom
and Right / Top) to 0 and 150

6.) Make sure the Backup Scale drop box field is Straight
Shift.

7.) Make sure the Grid type drop box field is Linear.

i Curve Heading

button to return to the log and the log will be initialized with the new layer, which in turn

Uil ¢ sp1: [35-139-23155

Mame: iT-"'pe w/ell Curve Curve Units; igapi '1
| Depth Urits: [t '] Null Value: 199325000
 Curve Scale -
[Lse O to O for the whale log] [Left £ Battarn]  [Right # Tap]
Drepth
Interval: !D-DD to iD-DU Scale:!D ta ]150
Backup Soale: Istraight shift 'l Grid Type: iLinear 71

cocn |

8.) Click on the L: | button to add the Type Well Curve
layer to the Drilling Progress Track.

Importing the LAS Type Well Curve

1. Click on the File pull down menu selection and click on Import and then click on LAS from the pop

out-menu or simply click on the s LAS button, on the Import Toolbar, to activate the LAS Reader

| « & er B
Date ’

2/18/2016 9:57 AM
2/18/2016 9:57 AM

\g PowerSteer Imperial Gamma Ray type well.las

87872016 10:16 AM

E PowerSteer Gamma Ray type well.las
Z, Imperial Horizontal Gamma Ray Curve.las

4/5/2016 1218 PM
83020121255 PM &
>

iF‘owerSteer Imperal Gamma Ray type well las

Open

window.
File | Edit View Reports Options Windc

onnect...

Disconnect

Access Registration v Look in: | SYSTEM
New Ctrl+N

Open... ctrl+0 Mame

Close =
(P MNTDrver

Import v AGS Data
Export s Ascll 1) 100741907 223w500
Backup Core Data

Print Log.. CtrisP SoreRhois

Print to TIFE k=

Print Morning Report... bl Seting = e

Print Well End Repart... L e g

Print Reports to Word ® g Vel £

Print Setup... ey

Percent (%) File name:

E“ . Perforations

e Ranged Data

Core Phote Profile Tool e Files of type: 1LAS (*las)

Surveys... '

'_T_i Cancsl )

2. This will then activate the Open window which allows the user to select the LAS file you wish to
import the data from. You can find the file in the PowerSuite_2018\System\PowerSteer Imperial

Gamma Ray type well.las and highlight the file by clicking on it once and then click on the
button. You will see the window shown below. It will default to the importing of Curve data.
3. On the lower left side of the window Click and drag the Gamma_Ray curve to the Type Well Curve
layer on the lower right side and release it when the layer name becomes highlighted.
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File View Help
SEEE 7
L8 PowerSteer Imperial Gamma | DEPT Gamma_Ray | A
L@ version 4010.679248 574635
L el 4011333408 575926
L@ curve 4011991568 57.7216
Lo Geen 4012.647728 374779
4013.303828 56.8628
4013.960048 56.2483
4014.616208 53.9634
4015.272368 55.6786
4015928528 56,5786
4016.584688 58,6495
4017.240848 60.7069 v
~
Choose Data Type: Curves :‘
Curve Deepth Eolurn [PEPT =1
Click and Drag with the Left Mouse button. Drag the columns of the data file over to the comesponding fisld ¥ Append Data To Curve
Narne [ Dese | Uis. Ttp Curve Layer ID | Esisting ID [ Mapped T
18§ DEPT 1DEPTH FT Proposed Well Path (TVD]  Proposed Well Path [TVD]
= 4010.6752¢
Et Gamma Py [ gapi B /el Path (5] wiell Path [55]
Base B8 well Path (TVD) ‘well Path (TVD)
e 44430 | B Drill Rate Dril Rate
. m Gamma Ray Gamma Fay
Step B Total Gas TolalGas
065616 ' Tupe well Curve Tupe Well Curve Gamma_R
Impojt
K3 > ~
Tutorial Well HZ [ NUM | 4

N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from
append to replace. The Symbol color will either be purple for replace or blue for append.

4. Click on the M button. You will then be prompted with a system message after the import has
finished.

Import Curves @

1) Finished Import

5. Acknowledge the Finished Import message. Click on the button and then click on the
button to exit or click on the File menu and select the Exit option to close the LAS Reader Window.

Removing the Type Well Curve Layer from the Tutorial Well HZ log.
This does not delete the type well curve but removes it from the log display.

1.) Under the Options menu, click on Log Configuration Builder or click on the E Log Configuration
Builder button on the Toolbar to activate the Log Configuration Builder window.
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| - Available Lags -
| Log. |[sveTEM -

i @ Tracks

Auto Test Interval Calcualtor
Bedding Contacts
Biotrbation

Bit Records

| I Par= Mensitn

|

| i Layers

Lag Canfig.

Add Al e
Shiw &l
Hide &1l
Add yis

Delete s
Show/Hide

Move

Exit | |

POWERY&UITE 2018

e L

Tutarial Well Horz Log _:j

Track Config. i

~

Log:

" Tracks

Dietailed Lithalogy
Slide - Rotate
Reservoir Quality
Raounding

Sorting

Girain Size
Interpreted Lithology
Forozity Grade
Porosity Type

0l Show

Depth 1

ing Prograss

Track Width: |2 Logwidh: |2
Laper Caonfig. l

fell Curve (1001 432083220500 |
ate (10014320632 3/500)

Gamma Fay (1001 43206322/500)
‘Total Gas (10014320632 3w/500]

& Layers
Ty 5

Engineering Parameters (100143206323
(10014320632 2w500)
(1007143206323w500)
(10014320632 3w500)

Mud Parameters
Gas Annotations
Bit Record

2.) On the right side of the Log configuration builder scroll down and highlight or click on the Drilling

Progress track.

3.) Click on the Type Well Curve layer in the layers portion of the window on the lower right side of the builder to
highlight it. In addition, notice the Layers Radio button  on the left side is activated.

4.) Click on the ﬂ] button and you will be prompted with the following system message.

|@] Do you want to DELETE the selected <LAYER> in the active log?

o ]

Note: The Type Well Curve data will not be deleted from the database. You are just deleting a layer that shows the
Type Well Curve data from the Tutorial Well HZ log.

5.) Click on theLJ button.
6.) Click on the st
Power*Steer

button to return to the log and the log will be initialized with this layer now deleted.

Now we will start up the Power*Steer Portion of this Tutorial.

Connecting to the Database

&

Bl
1.) Double click on the Power*Steer * Icon. This will initiate the program and activate a Connect

Database window.
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D atabazes

PEEOL
PGEOLD

L

User ID; Jpgeolog_l,l Connect

xxxxxxxx
Pasawiord; Cancel

4.) Highlight the PGEOLOGY 2018 IMPERIAL (Microsoft Access Driver[*.mbd])) database by clicking on
it once.

5.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the
User ID field. Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to
the Password field.

6.) Type “pgeology” in the Password field and then click on the button. The program will now
load various dictionaries and then activate a Well List window.

Choase Well L=
|
Pocerly Opernd — —
| | LA
V00T 180571 W
| Comelog 9 2002240440000

| Angbodes Typecal Carboriate el 10011240561 8w/S00
I«

i,
Impetiad Gt Log
24001201 300000
SYSTEM D)

ar

| oy e |
7.) Double Click on the Tutorial Well or Highlight the Tutorial well and then click on the
button. Because this is the first time the Tutorial Well has been opened it will be a blank template
starting at zero depths with no scales.

If you have not done the Power*Log and or Power*Curve tutorials this Well will not be in the list. Then
we must import The Tutorial Well. If you have done the tutorials then skip ahead to page 11 Set Well
path.

Import Log / Well Data.

If you have followed all the tutorials you can skip ahead to page 10. If you have not done the Metric
Power*Log Tutorial followed by the Metric Power*Curve Tutorial you will have no data available to you
to do this Power*Steer tutorial We will make this easy and have you import the Metric Tutorial
Horizontal Well. This will have the majority of the data and we will have add a Type Well curve to finish
off the set up of a Power*Steer example.

1. Select Import under the File menu selection, and then select Log/Well from the sub-menu. This will
activate the Import window.

Power*Steer Tutorial Page 8
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. PowerLog Data Transfer: Import V2018 — = EGH|
Files.. Goto Expart }

Delete Files

[Fie] Edit View Help Window

Exclude Files [

Open Ctrl+0
Close o Startimport
Refresh Data File: Header
: Tite of E sport: 2016/12/05 16:12 ~
Backgreund Graphic 4 Product: POWER"SUITE
i 3 r ersior: 2016.0.2.0
Import » Log / Well | Description: horz

Log Tulorial Wel HZ
Yol Name: Tutorial well
Export d Zones/Tops LIl 35-139-231595

Aipp Wer 2016.0.1.0

Storage Units: Imperial

Print... Ctrl+P [EXPORT OPT|ONS]
Log Configuration: Yes
Print Preview Entire WWell: vz
Today's Interval Mo
- 0.00ts0.00
Print SEtLIFI... Muorming Report:
Interval,
Exit Interval Data y Exit }

2.) Click onthe 7| button. This will activate the Import from window and now you will have to
browse to find the folder C:\POWERSUITE_2018\SYSTEM and then the file name you want to
import is Metric Tutorial Horizontal Log.exp.

Import From j=al
Lookin: | )i SYSTEM x| & @ ek Er
Name Date ) Type Ll
NTDriver 2/18/2016 %:57 AM File folder
100141901223w300 2/18/2016 9:57 AM File folder
___|Imperial Tutorial Core Log Facies Well.exp 8/5/2016 1:08 PM EXP File
i Imperial Tutorial Horzizontal Lag.exp 8/3/2016 3:09 PM EXP File
|| Métric Tutorial Core Log Facies Well.exp 5/19/2016 3:55 PM EXP File
__|Imperial Vertical Tutorial Well.exp 1/28/2015 4:30 PM EXP File
v
< >
Fileniame:  |Imperial Tutorial Horzizortal Log.exp
Fies oftype: [ Export fies [ exp) =l Cancel |

Note that files available for importing will have an .EXP file extension. Any of the files that you select will
then be added to the File list. Please make sure that the files you wish to import are highlighted
(selected), in the list prior to importing.

3.) Highlight the file name and click on the %=1 |putton.
4.) The Import Log/Well window will now be displayed with the details of the file to be imported.
Select/highlight the file to be imported.

5.) Click onthe —*™!™" hytton to activate the following system message, “Do you really want to
IMPORT the highlighted files?”

6.) Click on the fes button to proceed with the import.

Note: If you click on the “Yes” button, and the file you are importing contains the information from an
Entire Well, the following system message will be activated, “About to IMPORT ENTIRE WELL data. All
information associated with this well in the database will be OVERWRITTEN. Continue?”

7.) Clickonthe  **  button.
8.) Upon completion of the import, the following system message will then be activated, “Data has
been imported successfully.”

9.) Click on the

10.)Close the Data Transfer window by clicking on the _ e | button or by clicking on the ﬂ icon
located at the top right of the Data Transfer window.

button to confirm the successful import of the data.

Power*Steer Tutorial Page 9
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Refresh Data File | Edit View Window Help

If the well was opened and you have imported a newer file the Power*Steer N A

application must be refreshed to see the new data that has been imported. ;::;hom

Because we did not have the well opened at this time you would not have to  Background Graphic -

do this step. To refresh the data you would. IET::: :

1.) Click on the File Menu to activate the drop down list and Click on the :l::p =
Refresh Data Selection to refresh the well’s data you have open in Print Setup..
Power*Steer. £

Open Well
Now you have imported the Tutorial Well we now have to open the well.

1.) Click on the File Menu to activate the drop down list and click on the Open Selection to activate the
Well List.

Recently Opened

lowt
3R-139-23155

| Lhwtl
35133-23155

! File | View Help

| Cpen D? Ctri+ 0
Print Setup...
Exit 0K r_\l Carncel 1

2.) Select the Tutorial Well by double clicking on the well name or highlighting once and click on the
button.

This will open the Power*Steer with 2 panes and no data shown with the depths defaulted to zero (0).

Power*Steer Tutorial Page 10
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Bl e i Vem Help Wrde

D T8

Type Well

el Pathe V5 LAY MO 35750 TVD 100 in/Oue ALOG/000 (-187%)
—— — e

Dip’s #1080  riemabe 11008 aribes 3500 [Offoes: £.00
e E e ———

Power*Steer Well data needed from Power*Log / Power*Curve.
e A Well Path (TVD units) Curve has to be added and then calculated from the survey data.
e Survey data must also be up to date to display the information on the Power*Steer application.
e A measured depth Gamma Ray Curve must exist for the well being steered.
e A Type Well Gamma Ray Curve (TVD) must exist for the well to be steered.
e Zone of interest must be known and identified on the Type well.
e Formation Tops may be added and also have to have the thickness calculated in order to show
up in the list to be drawn in Power*Steer.

Set Well Path

1. Right click on the Well Path pane (right side) to activate the pop out menu
2. Select Set Well Path. This will activate a Select Curve Window.

Add Segment
Delete Segment
Change Azimuth

et Well Path N
Set Gamma
Overlay Curves
Segment Properties
General Properties
Show/Hide Tops
Show/Hide Zones
Show/Hide Perforations
Show//Hide Zone Fill

iwfell Path (TVD)

Cancel ] 0K 1

3. Select the steered Well Path Curve in TVD units from the drop down list by clicking on the down
arrow and selecting it from your curve list for this well from your database.

4. Click on the button.

Set the Gamma Curve

1. Right click on the Well Path pane (right side) to activate the pop out menu
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2. Select Set Gamma. This will activate a Select Curve Window.

| Add Segment |
Delete Segment
Change Azimuth

Set Well Path |
Set Gamma D} |
Overlay Curves

Segment Properties

General Properties
Show/Hide Tops
Show/Hide Zones
Show/Hide Perforations
| Show/Hide ZencFill |

3. Select the steered wells Gamma Ray curve in measured depth units from the drop down list by
clicking on the down arrow and selecting it from your curve list for this well from your
database.

Note: This Gamma Ray curve will be displayed on the lower portion of the well path and will either be

displayed in MD or VS depth units depending on the view. This is the curve that you will be attempting
to correlate to the Type Well Curve. It doesn’t necessarily have to be the Gamma Curve but this tool is
by far the most common tools to be run downhole while drilling.

4. Click on the button.

Set the Overlay Curves

If the user wishes to have more curves displayed on the Segment portion of the window the user can
also display those curves in either MD or vertical section depth display. These are only for display
purposes and will not be used to correlate to the Type Wells data.

1. Right click on the Well Path pane (right side) to activate the pop out menu
2. Select Overlay Curves. This will activate an Overlay Curves list.

Add Segment

Delete Segment

Change Azimuth —

[ 1Corz Rate
ZE"‘:'”’ et [0l Rate
et o

it G [ Gamma Fay
| Overlay Curves by

YT Ls- [IProposed Wwell Path [TVD)

| Segment Properties

General Properties TE’;EJ 1‘.-'-".53
Show/Hide Taps [ Pwéell Path (S5
Show/Hide Zones [ Twiell Path [T%D)

Show/Hide Perforations Cancel

Show/Hide Zone Fill

3. Select the Total Gas curve from the list and you may display other curves captured in your wells
database. Display these curves data by activating the check box beside the curves.

Note: These Overlay curves will be displayed on the lower portion of the well path and will either be
displayed in MD or VS depth units depending on the view. These curves are for display purposes only.
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4. Click on the button.

Set Type Well Curve
1. Right click on the Type Well portion of the screen (left side)
2. Select Set Type Well Curve from the pop out menu list. This will activate a Select Curve list.

| seTypewdiCuve |
Mapped Offset
Add Segment
Set Reference Point
Edit Reference Offset
Delete Reference Point I:I:!re Fiats
e Crrll Fate

armma Ray

Delete Zone | Propozed ‘Well Path [TVD)
Show Al Total Gas.
General Properties Typa Vel

3. Select the Type Well Curve that you will be steering to. This is Type Well GR curve you imported

into your steered well in Power*Curve.
4. Click on the button.

Type Well Depth Manipulation

ir\ﬁew Help  Window

Go To Depth (Type Well) | Measured Depth View
1. Click on the Type Well Portion of the window. E Fooiar ‘
2. Click on the View Menu to activate the drop down list. f i -
3. Click on Go To Depth (Type Well) selection to activate the Goto | f‘*: ge::: ”:'T:::” I i%

Window. il
4. Type a 7860 in the Type Well Depth Field.

Click on the button. This will change the depth view from 0 [fee0
to 7860 at the top of the type well. 0K ]  cancel

¥

Typewel Depth
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Type Well Track Depth Scrolling
Once the Type Well curve has been added to this track the user has the ability to scroll up and down the

curve depth display. _ B

Mouse Pointer Controls

The user can click on the up / down arrows on the right side of the
track pane to move up or down a bit or click on the space between
the thumb and arrows to move up or down 1/4 page.

Mouse Roller Ball Control
Click on the Type Well pane and then roll the roller ball away from
you to scroll up the view.

Click on the Type Well pane and then roll the roller ball towards you ; || -
to scroll down the view. ved & oo

Type Well Display Scale Manipulation

Click on the Type Well pane, hold the CTRL Key down on the keypad
and then roll the roller ball away from you to decrease the scale so
that you can see less data in the Type Well.

Click on the Type Well pane, hold the CTRL Key down on the keypad and then roll the roller ball
towards you to increase the scale so that you can see more data in the Type Well.

We‘f Help  Window

GO TO Depth (We” Path) | Measured Depth View
1. Click on the Well Path Portion of the window. @ v
2. Click on the View Menu to activate the drop down list. =
3. Click on Go To Depth (Well Path) selection to activate the Goto Window. | ... DEL,EH (W;”path, K '
4. T in the Well Path Depth Field. —
ype a 660 in the Well Pa epth Fie _ e
5. Click on the II' button. | -
‘wiell Path Depth
) ) ) |680
Well Path MD/VS Gamma Ray Depth Scale Display Manipulation ’Tk‘ B |

Click on the Well Path pane, hold the CTRL Key down on the keypad and then
roll the roller ball away from you to decrease the scale so that you can see less data in the Well Path
and MD / VS Gamma Ray.

Click on the Well Path pane, hold the CTRL Key down on the keypad and then roll the roller ball
towards you to increase the scale so that you can see more data in the Well Path and MD / VS Gamma
Ray.
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Well Path (Vertical Section) t} Click here to move
up a small amount
the TVD well path
scale, this will
move path the top
and bottom of the
scale

Click here to move
%uo a larger ameunt
the TVD well path
scale, this will
move path the top

and bottom of the
scale.

Thumb has been
disabled

1000 1100 1200 1300 1400 1500 1600 1700 1800 1800 Click here to move
down a larger
amount the TVD
well path scale, this
will move path the
top and bottom of
the scale.

Click here to move
down & small
164 F 038 amount the TVD

200 300 400 500 800 700 800 900 1000 1100 1200 1300 1400 1500 1600 1700 1800 1900 well path scale
this will move path
& [ [ ——. %7 the top and bottorn
| [NUM | of the scale
Click here to scroll the log click here to scroll the log back a 1/4 Thumb has been disabled Click here to scroll the log Click here to scroll the Iog ahead
back a few meters page Forward a 1/4 page a few meters

Well Path TVD Scale manipulation

Mouse Pointer Controls

The user can click on the up / down arrows on the right side of the track pane to move up or down a bit
or click on the space between the thumb and arrows to move up or down 1/4 page. This will move all
the scales (both top and bottom scales simultaneously).

Mouse Roller Ball Control
Click on the Well Path pane, hold the Shift Key down on the keypad and then roll the roller ball
towards you will move the TVD scale down (both top and bottom scales simultaneously).

Click on the Well Path pane, hold the Shift Key down on the keypad and then roll the roller ball away
from you will move the TVD scale up (both top and bottom scales simultaneously).

Click and drag up on the Well Path portion of the pane to see a more detailed view or less TVD range.
This action will not move the bottom TVD scale.

Click and drag down on the Well Path portion of the pane to see a less detailed view or more TVD range.
This action will not move the bottom TVD scale.

Well Path MD/VS Gamma Ray Depth Manipulation

Once the Well Path TVD curve, Measured Depth Gamma Ray curve has been added to these track the
user has the ability to scroll left and right to change the curve depth display.
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Mouse Pointer Controls
The user can click on the left / right arrows on the bottom side of the track pane to move left or right a
bit or click on the space between the thumb and arrows to go left or right 1/4 page.

Mouse Roller Ball Control
Click on the Well Path pane and then roll the roller ball away from you to scroll left or back.

Click on the Well Path pane and then roll the roller ball towards you to scroll right or forward.

Curve Display and Grid Pattern Manipulation
1. Right Click anywhere in either pane to activate the pop out menu.
2. Select General Properties. This will activate the General Properties window.

S (R I A
Set Type Well Curve Delete Segment Curve Settings | Forrnaﬁons! Zones | Screen Format ]
Mapped Offset Change Azimuth ] j I Jgnore NULL
Add Segment
Set Well Path r—Display Scale
Set Reference Point LAy m i ] S ID
Edit Reference Offset | 1
Owverlay Curves Right /Top- o
Delete Reference Point Segment Properties Fire e i1 Grd
Add Zone | General F’mpema [} | Line Style: iD Mejor 11
Diefste Zona Show/Hide Tops 11_‘
Show/Hide Zones e
Show "lﬁ‘” _ : Show/Hide Perforations
_ General Properties B | Show/Hide Zone Fill

Right Click Type Well Pane  Right Click Well path Pane
3. The default Tab selection is the Curve Setting tab. So now Click on the drop arrow and select the
Type Well curve to change the display for.

Curve Settings ] Formations | Zones | Screen Format ]

IT)'pe Well Li ¥ Ignore NULL
1~ Display Scale
[a]) - Lt/ [0
Right,/ Top: ]15{}
Line Size: i1 |- Grid
Line Style: lD Major IE’
Inc: i

4. Line Size portion of the window will change the line thickness from 1 to 20 (pixels wide). You
have to type a number in the size field and your input will be automatically displayed by the
curve.

5. Line Style portion of the window will change the line style. You have to type a number in the
style field from 0 to 3 and your input will be automatically displayed by the curve. 0=Solid line,
1=Dashed Line, 2=Dotted Line, 3=Dash Dot Line
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6. Scale Portion of window allows the user to change scales for the selected curve. Type a value in
the appropriate fields to change the scales. The scales will change as you type.

7. Grid Portion of window allows the user to change the grid pattern for the selected curve. Type a
value in the appropriate fields to change the grids. The grids will change as you type. Major
Grids will indicate a value. The minor grids will divide the whole track and not the majors.

8. Ignore NULL’s check box when activated will join curve values ignoring the null values. When
deactivated the curve will only draw when there are two consecutive data points.

9. Repeat Steps 6-8 to change the appearance of the other curves presented in Power*Steer.

10. Click on the in the upper right hand corner to exit this window.

Adding Zones

We will now add some Zones to the Type Well. They could be formation tops or other indicators that
you wish to mark on your Type Well and will be transposed and manipulated by your segment
movements in the Well Path pane.

1. Right Click at 7892 on your Type Well pane to activate the pop out menu.
2. Select Add Zone from the pop out menu list. This will activate the Add Label window.

Set Type Well Curve

Mapped Offset ﬁ;ﬂ;ﬂ[ﬂh& n

Add Segment
Set Reference Point
Edit Reference Offset | Red Sky

Delete Reference Point -
" Top O Base

Add Zone %

Delete Zone

Show Al Cancel ‘ o, |

General Properties

3. Typein a Red Sky in the field provided.
4. Click on the [_%_Ibutton. This will close the window and add the Red Sky Zone Label to the Type
Well pane.

Note: The label will only be seen on the Well Path Pane after you have added a Reference Point

5. Right Click at 7906 on your Type Well pane to activate the pop out menu.
6. Select Add Zone from the pop out menu list. This will activate the Add Label window.

Set Type Well Curve
M d Offset S AT

e Add La
Add Segment
Set Reference Point |
Edit Reference Offset |HE':| Sky Main Sand

Delete Reference Point - T oo B o
u]
Add Zone % R

Delete Zone

Show Al Cancel ‘ o, |

General Properties

7. Type in a Red Sky Main Sand in the field provided.
8. Click onthe [_%_Tbutton. This will close the window and add the Red Sky Main Sand Zone Label to
both the Type Well pane.

Power*Steer Tutorial Page 17



POWE@?{%UITE‘"ZOIS Power*Steer Tutorial

9.

Right Click at the 7969 on your Type Well pane to activate the pop out menu.

10. Select Add Zone from the pop out menu list. This will activate the Add Label window.

11.

12.
13.

14.
15.

16.

17.
18.

19.
20.

Set Type Well Curve
Mapped Offset ﬁﬂﬂ"lﬁbﬂi “
Add Segment

Set Reference Point
Edit Reference Offset |z|:|| [T DF']

Delete Reference Point = -
+ Top O Base

Add Zone %

Delete Zone

Show Al Cancel ‘ o, |

General Properties

Type in a ZOI (Top) {ZOl is an acronym for Zone of Interest} in the field provided.

This is a zone marker that indicates that you are inside the designated target and you would like to
calculate the percentage of the well’s path that is inside the target boundaries then you must
indicate whether this label is the top or base of the Zone. The user can only have one label
designated at top and one zone label that is designated as base.

This is the primary target label indicator then you must click on the ® Ter T a2 pytton.

Click on the [_%__| button. This will close the window and add the ZOI (Top) label to the Type Well
pane.

Right Click at the 7974 on your Type Well pane to activate the pop out menu.

Select Add Zone from the pop out menu list. This will activate the Add Label window.

Set Type Well Curve
Mapped Offset ﬁddLa‘bel “
Add Segment

Set Reference Point

Edit Reference Offset |2|:|| [B EISE]

Delete Reference Point o e oy Ease

Add Zone % R

Delete Zone

Show Al Canhcel ‘ (1] 4 [

General Properties

Type in a ZOI (Base) {ZOl is an acronym for Zone of Interest} in the field provided.

This is a zone marker that indicates that you are inside the designated target and you would like to
calculate the percentage of the well’s path that is inside the target boundaries then you must
indicate whether this label is the top or base of the Zone. The user can only have one label
designated at top and one zone label that is designated as base.

This is a primary target label indicator then you must click on the © Tap  © Base pbuseon,
Click on the [__%__|button. This will close the window and add the ZOI (Base) to the Type Well
pane.

Right Click at 7990 on your Type Well pane to activate the pop out menu.

Select Add Zone from the pop out menu list. This will activate the Add Label window.
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Set Type Well Curve
Mapped Offset
Add Segment

Set Reference Point
Edit Reference Offset Red5S k_',' Bazal Shale

™ Top O Base

Delete Reference Point

.-.Md Zone h
Delete Zone
Show All Caticel I aF. I
General Properties

21. Type in a Red Sky Basal Shale in the field provided.
22. Click on the button. This will close the window and add the Red Sky Basal Shale Zone Label
to the Type Well pane.

The zone labels will be added to the Well Path Pane after you put in a reference point and then add the
first segment.

CA Fle Edit View Help Window

Well Path (Vertical Section)

597

00 EL] 0 Taaa T 100 1200
1
1970800 S N T r
VYA YO O L i
. s -7
To80 T o -
] '.I
7450504 Sy Basal Shaln
I i i : 700 00 00 1000 1100 1200 |
v v
< > < >
Well Path: VS 1215.06, MD 853,38 TVD 814774 InOut: 0.00/0.00 {-1.81%) Dig': 1,00 | Azimuthe: 110,00 [Stike: 90,00 [Dffset: 0.00
T e ——r—— B W YT AT T T

Zones Display Properties
1. Right Click anywhere in either pane to activate the pop out menu.
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- - B Add Segment Curve Settings | Fornations | Zones | Screen Formet |
Set Type Well Curve DEjere Segment I =] ™ fgnore NULL
Mapped Offset Change Azimuth e e
Add Segment Set Well Path . | — Left/Bim [°
Set Reference Paint Set Gamma Right/Tap-: ID
Edit Reference Offset | Overlay Curves Line Size: I1 |~ Grid
Delete Reference Point (remest hioperte: Line Style: iD Major ]1
A Fars l General Properties [} i ]—'1
Deliete Zone Show/Hide Tops
Show/Hide Zones
Show All Show,/Hide Peforations
| GenelPropeties |\ || ShowkideZone Fil

2. Select General Properties. This will activate the General Properties window.

3.

Click on the Zones Tab to activate the Zones display properties.

Note: Zones will only appear in this list if they been entered in the Type Well Portion (left side) of the
Geo*Steer application.

4. Click on the drop arrow and select the zone you wish to change the display for.

You can change the display name if you wish by typing in a new Zone name. These can be tops or any
other indicators you wish to display in the Well Path Section of the Geo*Steer application.

9.

Curve Settings ] Formations ~ Zones I Screen Format ]

|Red Sky Basal Shals -] Color| N Basic :
o o HrEECENN
Text LineSize:! i el § O |
|Red Sky Basal Shals n fu— = EEEEE
| Bk (1 B 0NN
Type Wel Depth [2435.5  Top C Base Reset - . EEEEE
HEEENFEET

Custom colors:
I N1 O O 1 O A
| O A
Define Custom Colors > ‘

oK Cancel |

If you wish to change the color of the Zone line then you can click on the %] B putton to
activate the Color pallet. Select a new color and then click on the button.

Line Size portion of the window will change the line thickness from 1 to 9 (pixels wide). You
have to type a number in the size field and your input will be automatically displayed by the
curve.

Line Style portion of the window will change the line style. You have to type a number in the
style field from 0 to 3 and your input will be automatically displayed by the curve. 0=Solid line,
1=Dashed Line, 2=Dotted Line, 3=Dash Dot Line.

If you choose to change the Type Well depth and or the @ Top @ Base gase or Top of zone

then you must click on the E’i] button
Repeat steps 4-8 for changes to other zone lines.

10. Click on the “ in the upper right hand corner to exit this window.
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Set Reference Point

First thing you have to do is set up a reference point. You will need to know the general strike and dip of
the formation you wish to steer this well for and the depth offset so that you can move the steered
wells curve data up or down to match near the zone of interest. This offset is critical for display
purposes and should be correlated to the last Formation top encountered before the zone of interest
to be drilled along is encountered. This can be changed after the fact but will affect the segments that
have been manipulated if done after the fact. The Strike and Dip will not be allowed to change. If you do
want to change the strike and dip then you will have to delete the Reference point and that will delete
all the segments that have been entered so you will be starting anew.

So it is quite important not to set up this reference point too soon as the segment manipulation is quite
dependent on dip and if your well bore is less than 80 degrees inclination then you are manipulating bed
thickness and not bedding dip, azimuth and or faulting.

1. Right Click on the Type Well Pane at 7740 which is a little above the depth that we wish to start our
correlations and select Set Reference Point from the pop out menu. This will activate the Reference
Point window.

o 2rence Point El|
Mapped Offset
Add Segment :
Set Reference Point MD Depth 5 Depth  Dip Azimith
Edit Reference Offset 8181.3538" |?50.55503= ]'1 ]315
Delete Reference Point
Add Zone Type Wwell Offset (TVD]: |5
Delete Zone
A 0K i Cancel ‘
ow

General Properties

Note: The Reference Points Dip and Azimuth refers to the regional Strike and Dip in the area for your
drilled zone of interest. The Type Well Offset moves your steered well up or down to match with the
Type well. A negative number will move your steered well being drilled up and a positive number in this
field will move your correlatable well down. This offset and steering should really be done when you are
near your zone of interest.

2. Inthe Reference Point window the default Dip and Azimuth are OK for this tutorial. Normally the
user will fill in the Regional strike and dip. The defaults are (1 degree) and strike azimuth (315
degrees) for our intended formation or zone you wish to steer.

3. Tab key to advance and highlight to the Type Well Offset field and type -0.5 in the Type well offset.

4. Click on the [_%_Ibutton. Once the reference point has been set you will see a pink line in both
the Type Well and your correlating well as shown above
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Well Fath (Vertical Section)

200 1000 1100 1200 1300 1400 1500 1600 1700 1500 1900 2000 2100 2200 2300 2400

“ o oot s il Bt 1 oot

| 700 800 00 1000 1100 1200 1300 1400 1500 1600 1700 1800 1900 2000 zigg | Enghoh (Uned States
TR0

< > < prase

‘Well Path: VS 1673.16, MD 532743, TVD 805432 In/Qut: 2155.50/231.50 (90.46%) Dip™: 100 [Azimuth Windows key+Space | 1]
ey C o EEE——ma L Emee—teremrerens T T = oy Foroe

Segments

This is the nuts and bolts of the Power*Steer application and we should spend some time explaining
what a segment does for you. A segment consists of various integral pieces of data that has Vertical
Section depths from and to, Measured Depths from and to, True Vertical Depths from and to along with
Dip angle, Azimuths and throws. All the Segment data is manipulated on the type well by shrinking and
extending the VS start and VS end points, moving the entire segment to create a throw (indicated by a
fault on the Well Path Pane) or changing the Segment Azimuth.

Segment Definition

A segment is a depth range on the Gamma Ray trace (either MD or VS depth range) that is then
converted to TVD depth on the Trace Well. To select a segment you will have to click on the segment
marker (arbitrary color) which is defined below the Vertical Section / Measured Depth Gamma Ray trace
from the active well. Once the segment is clicked on you will see the Steered Well Gamma Ray curve
(turns red) to make it active on the Type well and it will have a VS start line and VS finish line on both
the Type Well and Well Path Panes. The Gamma Ray trace may go down or up or both depending on the
well path over the segment interval. The segment trace on the Type well will appear red when going
down and black when going up.

Add the first Segment

(First one is different than all the rest) The top of this segment cannot be ;“T"'p;:':” s
appe set
refined with a change of dip or azimuth. It is just a starting point. The rest of -Ad-:-:egment
the segments after the first can be redefined on both the VS Start and VS End 5ot Retesencea Paink
or create some faulting. | EditReference Offset
Delete Reference Point
1. Right Click @ 7742 somewhere near, (but deeper than your reference | AddZone
point and Select Add Segment from the pop out menu. it
Show All
General Properties
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The first segments Gamma Ray data will be displayed on your Type Well as a red curve and will be
placed at the offset depth that was entered into your Set Reference Point. The display depths for the
Gamma Ray curve on the Type Well pane have been recalculated from its Measured Depth / Vertical
Section Depths to True Vertical Depth so the user can attempt to correlate to the type Well. The first
segment will extend to the end depth of your current Survey data and will omit any Gamma Ray Curve
data beyond that as it does not have any TVD depths associated to represent that data.

Note: You can only manipulate the bottom of this first segment (VS End).

Adding more Segments.

1. Right Click @ 771 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the pop
out menu.

2. Right Click @ 787 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the pop
out menu.

3. Click on the segment just created from 771 to 787 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end

A I
e Edit View Help Window ROE
T8
“
| O T R T 1150 e
774 m L i
| [ Bad Gioe idaih 2and |
a1
13
1355
L2 Tepl |
TR ZOTIETRT
-Bad Gkv Basal Shals
750 Te0 Tp 190
T -
{
|
i |
|
L -
I = 2 ! A _m_
50 160 70 T80 90
TTTOL
< » < »

Weell Path: VS T76.39, MD 222200, TVD 304341 I/ Qut: 0.00/0.00 (-1.25%) Dip®: 100 Azimuthe 110.00 Strike: 31500 Offset: -0.50
ey © o EESs—may L Eee—cm T T = Tm— ErwseTITEE—E———————

Changing the bedding angle of a Segment
1. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
2. If you were to move the mouse pointer to hover over the VS End marker (blue line above and

right) the cursor will turn into a I as shown above.
3. Click and drag the VS End down to match the GR peak in the type well. This will change the
bedding angle from 0.42 to approximately 1.71 degrees.
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B3 Fie Ede View Help Window
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Extending the Segment

1. Then hold the Shift key down and roll the scroll button on your mouse towards you and stop
when it gets to 2371. This is where the GR Segment changes and does not perfectly match the
Type well.

2.

You can also hold the Shift key down and Mouse over the end of the segment on the Well Path

pane and when it turns into an ++* arrow click and drag left or right to shrink or extend the
segment.

You may have to click on the Type Well pane if you see the scale change in the Well Path pane.

3. You will want to double click on the Red Segment from 771 to 787 and this will keep the
segment visible on the Type Well after you initiate the next segment.

Adding another Segment

1. Right Click @ 830 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the

pop out menu.
Click on the segment just created from 787 to 830 VS to highlight the Gamma Ray section (Red

(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.
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3 Fle Edit View Help Window

Well Path [Vertical Section)
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Changing the bedding angle of a Segment

4.

Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
If you were to move the mouse pointer to hover over the VS End marker (purple line above and

right) the cursor will turn into a ! as shown above.

Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.40 to approximately -0.65 degrees.

You will want to double click on the Red Segment from 787 to 830 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.

[ Fite Edit View Help Window

e

0 7 150 —
14T
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7780|

S

Well Path (Vertical Section)
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Adding another Segment
3. Right Click @ 984 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
4. Click on the segment just created from 830 to 984 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.

File Edit View Window

0|2 L

Help

Teaq

Taa0

vl Pl i
B10 #20 |B30 B840 B0 BAD B70 BB0 B90 G900 910 020 O30 940 040 60 G70 GHD 980 1000 1010 1020 1030 1030 1080

7850

S am naze
ol | - | ———} 800 810 B20 B30 B840 HS0 BED HYO0 B0 BE0 G900 910 SJ0 990 940 S50 GE0 WHI0 GB0 S0 1000 1010 1020 1030 1040 1050

€ 3 € >
Well Path: VS 967.10, MD 830485, TVD 2115.83  Im/Quk 00000 (1,21%) g™ 100 Azimuthe 11000 Steike: 515,00 (Offset 050
e —— T e T e Tt T

Changing the bedding angle of a Segment
6. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
7. If you were to move the mouse pointer to hover over the VS End marker (greed line above and

right) the cursor will turn into a I

6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.42 to approximately 0.03 degrees.

7. You will want to double click on the Red Segment from 830 to 984 and this will keep the
segment visible on the Type Well after you initiate the next segment.
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Well Path (Vertical Section)

Total Gas
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Well Path: VS 812,82 MD 827837, TVD 805250 In/Out: 0.00/0,00 (-14)%)

Dip*: 100 Azimuth: 11000 Strike: 315.00 |Dffset: -0.50

Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. Right Click @ 1181 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
3. Click on the segment just created from 984 to 1181 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.

FA e Bt View Hep
0|5 e

Window

T8

Well Path (Vertical Section)
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‘Well Path: VS 116264, MD 875,48, TVD 8112.58 In/Out: 0.00/0.00 {-1.5%) Dig™ 100 Azimwthe 110.00 Strike: 315,00 Offset: -0.50
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (purple line above and

right) the cursor will turn into a I as shown above.
6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.45 to approximately -.04 degrees.

Well Path (Vertical Section)

VS St

oy

78708

¥

788

Y'I

gy siesessal snle

LUl
980 980 1000 1010 1020 1020 1040 1050 1060 91070 1080 1080 1100 1110 1120 1130 1140 1150 1160 1170 #1180 1100

L8 Wi WY i
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|

79104

4

980 980 1000 1010 1020 1030 1040 1050 1060 1070 1080 1080 1100 1110 1420 1130 1140 1150 1160 1170 1180 1180

>
RSD Curve (Type Well Curve) : RSD {TVD) Depth 7917.01, MD Depth -1.00, Value 100.1 Dip*: 100 Azimuth: 110.00 [Strike: 315.00 [Offset: -0.50

Extending the Segment

1. Then hold the Shift key down and roll the scroll button on your mouse towards you and stop
when it gets to 7956. This is where the GR Segment changes and gets a little off below this
depth.

2. OrYou can also hold the Shift key down and Mouse over the end of the segment on the Well
Path pane and when it turns into an ++ arrow click and drag right to extend the segment to
1626.

3. You will want to double click on the Red Segment from 984-1626 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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[ File Edit View Help Window
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Well Path: VS 173801, MD 8414,81, TVD 805318 In/Out: 0.00/0:00 (-1.2)%) Dip*: 100 Azimuth: 110.00 Strike: 315.00 [Offset: -0.50

Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. Right Click @ 1706 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
3. Click on the segment just created from 1626 to 1706 VS to highlight the Gamma Ray section
(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators.

3 Fle Edit View Help Window —ie]x
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Well Path [Vertical Section)
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RED Curve: ﬂ: Well Curve) : RSD (TVD) ﬁh TS4T.04, MD Depth -1.00, Value 14854

Dig™: 100 Azimuthe 110.00 Strike: 315,00 Offset: -0.50
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (purple line above and

right) the cursor will turn into a I up/down arrow.

6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.68 to approximately -0.55 degrees.

7. You will want to double click on the Red Segment from 1626 to 1706 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.

T8

Well Path (Vertical Section)
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79608

I T
? 1840 1650 1660 1670 1680 1680 1700} 1710 1720 1730 1741
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Well Path: VS 1583.38, MD 823403, TVD 805408 In/Out: 0.00/0.00 (-154%) WS_FTP Pre Dip®t 100 |Azimuths 110,00 [Strike: 315,00 |Offset 0,50

Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. Right Click @ 1853 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
3. Click on the segment just created from 1706 to 1853 VS to highlight the Gamma Ray section
(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators.
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the

segment on the Type Well.

5. If you were to move the mouse pointer to hover over the VS End marker (blue line above and

right) the cursor will turn into a I up/down arrow.

6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.6 to approximately -0.7 degrees.

8. You will want to double click on the Red Segment from 1706 to 1853 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. Right Click @ 2043 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
3. Click on the segment just created from 1853 to 2043 VS to highlight the Gamma Ray section
(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators. This where the well goes from getting deeper to getting shallower.

@

Bl e Edit View Help Window
o= T8

Well Fath (Vertical Section)
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‘Well Path: VS 203111, MD 5633.12, TVD 8043484 In/Qut: 0.00/0.00 {-1.8)%) Dig™: 100 | Azimuthe 110.00 Strike: 315,00 Offset: -0.50
— T e Sr—m——— T T T T Y T ——

Changing the bedding angle of a Segment
1. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
2. If you were to move the mouse pointer to hover over the VS End marker (blue line above and

right) the cursor will turn into a I up/down arrow.

3. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.6 to approximately 0.04 degrees.

4. You will want to double click on the Red Segment from 1853 to 2043 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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[ File Edit View Help Window
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Well Path: VS 2115.87, MD 973,00, TVD 804839 In/Out: 0.00/0:00 (-1.2)%)

Dip' 100 [Asimusth: 110,00 || Friday, November 25, 2016

Adding another Segment

1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.

2. You will now want to expand the Type Well Scale by Clicking on this pane and holding the CTRL
Key down and rolling the roller ball on your mouse away from you to increase the scale.

3. Right Click @ 2257 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.

4. Click on the segment just created from 2043 to 2257 VS to highlight the Gamma Ray section

(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators.

O Fie Edt View Help  Window

D2 T8

Well Path (Vertical Section)

2300

Wil Path: W5 224713, MD 50431, TVD 804000 I/ 000000 (-1.27%) Dip 100 \Asimath: 11000 Stedke: 315,00 [Ofset: -0.50
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Changing the bedding angle of a Segment
1.

segment visible on the Type Well after you initiate the next segment.

Click once on the Segment Marker below the Gamma Ray curve (shown on previous page) to
highlight the segment on the Type Well.
If you were to move the mouse pointer to hover over the VS End marker (blue line above and

right) the cursor will turn into a I up/down arrow.

Click and drag the VS End down to match the GR low reading in the type well. This will change
the bedding angle from 0.71 to approximately 1.32 degrees.

You will want to double click on the Red Segment from 2043 to 2257 VS and this will keep the

Well Path (Vertical Section)
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>
Well Path: VS 2241.29, MD 9898.47, TVD 804736 In/Out: 0.00/0:00 (-1:21%) Dip®: 100 |Azimuth: 110.00 [Strike: 315.00 [Offset: -0.50

Adding another Segment

1.
2.

Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
You will now want to expand the Type Well Scale by Clicking on this pane and holding the CTRL
Key down and rolling the roller ball on your mouse away from you to increase the scale.

Right Click @ 2600 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.

Click on the segment just created from 2257 to 2600 VS to highlight the Gamma Ray section
(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators.
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[l Fie Eda View Help Window
D2 T8

Well Path (Vertical Section)
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Wil Path: W5 224713, MD 50431, TVD 804000 I/ 000000 (-1.27%) Dip 100 \Asimath: 11000 Stedke: 315,00 [Ofset: -0.50

Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown on previous page) to
highlight the segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (blue line above and

right) the cursor will turn into a I up/down arrow.
6. Click and drag the VS End down to match the GR low reading in the type well. This will change
the bedding angle from 0.21 to approximately 0.7 degrees.
5. You will want to double click on the Red Segment from 2257 to 2600 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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Well Path: VS 2375.81, MD 10033.00, TVD 8046,55 _In/Out: 0.00/0.00 (-15%) Dip®: 1,00 |Asimuth: 110.00 [Strike: 315,00 [Offset: 0,50
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The Last Segment
1. Scroll right (deeper) on the Well Path pane.

2. Click on the segment from 2600 to 2976.74 VS to highlight the Gamma Ray section (Red (Well
bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end

indicators.

3. Asfar Aslcantell they are lined up over each other so you are now done with the Power*Steer

portion of the tutorial.

FA fie Bt View Help Window
o= 8

Well Path [Vertical Section)

€ > €
Well Path: VS 204837, MD 1060583, TVD 2039.39 In/Out: 0.00/0.00 (-1.0/%)

Dig™: 100 Azimuthe 110.00 Strike: 215,00 Offset: -0.50
ErwseTITEE—E———————

Zone Fills
The zone fills option adds some color to the final product.

1. Right Click on the Well Path / GR Panes to activate the pop out menu.
2. Select Show/Hide Zone Fill. This will turn on the Zone fill color scheme shown

below.
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Well Fath (Vertical Section)
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Calculate In / Out

This menu selection works with the zones that were added and where the zones were indicated as the
top and base. When those are defined the user can select this Edit menu selection and it will calculate
the amount of well path that is in the zone and the amount of well path that is out of the zone. This
calculation is started when the well path first encounters the top of your zone of interest.

1. Click on the Edit Menu to activate the drop down list and select Calculate In / Out.
This will be printed in the output as well as displayed in the Status bar when your
mouse pointer is focused in the Well Path portion of the window.

Edit | View Help Window

Redo Update Segment
Undo Delete Segment

Well Pathe V5 1847.60, MD 9504.29, TVD 7982.73 In/Out: B26.530/231.30 (78.12%%) Calculate I/ Out N
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Print Filg_gc::n View Help W\nd£:|+0 j
1. Click on the File Menu to activate the drop down list. E;h -
2. Click on Print selection or click on the ] Print button on the Toolbar to ‘E“"f*:“”‘“”““"‘ :
activate the Print Options window shown below. Er:::n ’
3. VS /MD Range portion of the window indicates the Vertical Section ([l o |
depth range or Measured Depth Range you wish to print. Type in the pt;atp
depth range in the fields provided. Bit

(Your Power*Steer application may be in Measured Depth [MD Range] units.)
4. Well Path Scale portion of the window indicates the TVD depth range you wish to print. Type in
the TVD depth range in the fields provided.
5. Type Well Width field is how wide you want to print this portion of the Power*Steer window.
Type in a width in Inches in the field.
The depth scale interval and scale of the Type well will be determined by what is viewed on your screen
and the paper size an orientation.

6. Border field is how much border you wish to :
have around the top, bottom, and left edges Print Options E3]
of your print. Type in a border width in Y5 Range - Header
inches in the field. [1200 o 7000 ST D

7. Print field drop box is the VS Depth Scale of Wwiel Path Scals [t CD'DLBMFJ
your print. Click on the drop box and select Top [7320 Base [BOT0 Tope el
from the List or the user can also Type a VS oot [F [Bpetee Gre
depth scale in the field. e Intesprset

8. Click on the Service Company logo e {025 e
button to search your computer for a logo to Print
put in your header. AdalsElE :

9. Type in the Type Well Name / Location is PirlerSep | - [FtoPage = [ ]
the Type Well field. Depress the tab key on e
your keypad to advance the cursor to the

Interpreter field.
10. Type in the Interpreters name who created the interpretation in the Interpreter field.

@ button allows the user to setup the printer for the Power*Steer output

11. When you are ready to print your Power*Steer log, click on the button.
Power*Curve / Power*Steer display
This is another way to display the lithology in the Power*Curve module in the detailed lithology track of

our default logs. The normal curve fill would be the well path but we will now show you a Power*Steer
curve fill layer.

Connecting to the Database

7 ﬁ‘;

L eI
1.) Double clickonthe “# |con. Acknowledge the Security Information window by clicking on the

button. This will initiate the program and activate a Connect Database window.
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D atabazes

PREOLOGY 2012 IMPERIAL [Microsaft
FGEOLOGY 2018 METRIC (Microsoit Ac

User ID; ipgeolog_l,l Connect

Cancel I

2.) Highlight the PGEOLOGY 2018 IMPERIAL (Microsoft Access Driver[mbd])) database by clicking on it once.
3.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field.
Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field.

4.) Type “pgeology” in the Password field and then click on the button. The program will now load
various dictionaries and then activate an Open Log window.
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Most Recently Dpened Logs

H Tutorial el Horz Log
W Tutarial well

~ Search Wells by Field or DLSNTS

Mate: ‘Wildcards : % = any range, _ = single character
Choose field to search
y/ell Mams | Ll | Spud Date: = juw |
35-1358-23155 Aug 13, 2015 Erter Search Sting

=

- Field

- DLS (Domirion Land Survep System)
Survey
System Loc Ex LSO Sec. Township Range E/W Mer 044 ES.

] O o

~ MTS [Mational Topographic Series Syshemn]

Survey sl
Sypsterloc Ex 14 Unit Block P, GQuad L Quad: Sistesnth EiS:

< 1L ]

Ayailable Logs

H Tutanal'Wwell HZ

Seach | @ ByField " ByDLSMNTS  Clear Quey |

cous |

Most Recently Opened Logs

H Tutorial el Horz Log
W Tutarial well

~ Search Wells by Field or DLSNTS

Mate: ‘Wildcards : % = any range, _ = single character
Choose field to search
well Narne | U | Spud Date: juw |
(T el we 100143205323w500 Jan 3, 2015

- Field

Enter Search Strin'g

=

- DLS [Damirian Land Survey System]

Survey
System Loc. Ex LSD Sec. Township Range EAW Mer 074 E.5.

] o

~ MTS [Mational Topographic Series Systemn]

Survey o
Sypstervloc Ex 14 Unit Block P GQuad L Quad: Sistesnth EiS:

< L ]

Ayailable Logs

Search | @ ByField " ByDLS/NTS Efear!]uéw|

cous |

Vel Horz Log

5.) Select the Tutorial Well from the List and then click on the button. This will open your Tutorial
Well Horz Log.
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“ing Progress

[For Help, press Fi

pgeology [UPDATE [KB: 82

6.) Click on the Detailed lithology track once to highlight the track in green.
7.) Click on the layer Selection list and click on or select the Curve fill layer. This will make active the
Curve fill layer.

8.) Double click anywhere within the Curve Fill layer to activate the Curve Fill Options window. This will activate
the Choose Curve Editor shown below.

Curve Fill Dptittgs_l ‘wiell Path O ptions

Cancel

Curve Fil Ot
9.) Click on the Mﬁ-‘ button to activate the Curve Fill Options window.
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10.) Click on the Fill Modes — 1 Curve drop box and Select Power*Steer.
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11.) Click on the ﬂ button in the Curve fill Options window. The window will close and the changes you have made
will be reflected on the layer.
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This concludes your Power*Steer Tutorial

Power*Steer Tutorial Page 42



